
Troubleshooting Guide

HP t610 Series Flexible Thin Clients



© Copyright 2012 Hewlett-Packard
Development Company, L.P. The
information contained herein is subject to
change without notice.

Microsoft and Windows are trademarks of
Microsoft Corporation in the U.S. and other
countries.

The only warranties for HP products and
services are set forth in the express
warranty statements accompanying such
products and services. Nothing herein
should be construed as constituting an
additional warranty. HP shall not be liable
for technical or editorial errors or omissions
contained herein.

This document contains proprietary
information that is protected by copyright.
No part of this document may be
photocopied, reproduced, or translated to
another language without the prior written
consent of Hewlett-Packard Company.

Second Edition (June 2012)

First Edition (May 2012)

Document Part Number: 681071-002



About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product features

Standard features
Thank you for purchasing an HP thin client. We hope you have years of use from our HP t610 Series
Flexible Thin Clients. Our goal is to provide you with award-winning clients that are easy to deploy
and manage with the power and reliability you expect.

The next sections describe the features of the thin clients. For a complete list of the hardware and
software installed on a specific model, visit http://h10010.www1.hp.com/wwpc/us/en/sm/WF04a/
12454-12454-321959-338927-89307.html and search for a specific thin client model.

The thin clients exhibit the following features:

● no diskette drives

● 5-minute setup time

● central deployment and management using a broad range of easy and scalable remote
management solutions

Various options are available for your thin client. For more information about available options, visit
the HP website at http://h10010.www1.hp.com/wwpc/us/en/sm/WF12a/12454-12454-321959.html.

Standard features 1

http://h10010.www1.hp.com/wwpc/us/en/sm/WF04a/12454-12454-321959-338927-89307.html
http://h10010.www1.hp.com/wwpc/us/en/sm/WF04a/12454-12454-321959-338927-89307.html
http://h10010.www1.hp.com/wwpc/us/en/sm/WF12a/12454-12454-321959.html


Front panel components
Figure 1-1  HP t610 Thin Client (left) and HP t610 PLUS Thin Client (right) front panel components

(1) Power button (4) Line-out (headphone) audio connector

(2) Flash activity LED (5) Universal serial bus (USB) connectors (2)

(3) Line-in (microphone) connector   

For more information, refer to the model-specific QuickSpecs at http://h18004.www1.hp.com/products/quickspecs/
QuickSpecs_Archives/QuickSpecs_Archives.html.
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Rear panel components
For more information, http://www.hp.com and search for your specific thin client model to find the
model-specific QuickSpecs.

Figure 1-2  HP t610 Thin Client rear panel components

(1) DVI-I connector for DVI-D and VGA output (6) Serial connector

(2) DisplayPort connector (7) PS/2 connectors (2)

(3) Ethernet RJ-45 connector (8) Power cord retention slot

(4) Universal serial bus (USB) connectors (2) 2.0 (9) Cable lock slot

(5) Universal serial bus (USB) connectors (2) 3.0 (10) Power connector

Rear panel components 3
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Figure 1-3  HP t610 PLUS Thin Client rear panel components

(1) DVI-I connector for DVI-D and VGA output (7) PS/2 connectors (2)

(2) DisplayPort connector (8) Power cord retention slot

(3) Ethernet RJ-45 connector (9) Cable lock slot

(4) Universal serial bus (USB) connectors (2) 2.0 (10) Parallel connector

(5) Universal serial bus (USB) connectors (2) 3.0 (11) PCI-Express expansion slot

(6) Serial connector (12) Power connector
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Installing the rubber feet
CAUTION: To prevent loss of performance or damage to the thin client, be sure to install the rubber
feet before operating the thin client in a horizontal orientation.

To install the rubber feet:

1. As you face the front of the thin client, lay the thin client on its left side.

2. Remove the feet from their backing.

3. Press each foot down securely onto a corner of the right side of the thin client.

Figure 1-4  Installing the rubber feet
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Installing the stand
If the thin client will be installed in an vertical orientation and it will not be mounted, the stand should
be installed for stability.

To install the stand:

1. Turn unit upside down.

2. Locate the slots on the bottom of the unit into which the tabs on the stand fit.

3. Insert the tabs into the slots, and then slide the stand about 1.26 cm (1/2 inch) toward the front
of the unit until it locks into place.

Figure 1-5  Installing the stand
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Removing the stand
To remove the stand:

1. Turn unit upside down.

2. Press the tab (1), and then slide the stand about 1.26 cm (1/2 inch) toward the back of the unit
and lift the stand off the unit (2).

Figure 1-6  Removing the stand
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Using the power cord retention slot
To prevent accidental disconnection, press a loop of the power cord into the power cord retention
slot.

Figure 1-7  Power cord retention slot (HP t610 PLUS Thin Client pictured in horizontal orientation)

Serial number location
Every thin client includes a unique serial number located as shown in the following illustration. Have
this number available when contacting HP customer service for assistance.

Figure 1-8  Serial number location
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2 Hardware changes

General hardware installation sequence
To ensure the proper installation thin client hardware components:

1. Back up any data, if necessary.

2. If the thin client is powered on:

a. Turn the unit and any other attached devices off.

b. Disconnect the power cord from the wall outlet.

c. Disconnect any external devices or cables, such as a cable lock.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components
to cool before touching.

WARNING! To reduce the risk of electrical shock, fire, or damage to the equipment, do not
plug telecommunications or telephone connectors into the network interface controller (NIC)
receptacles.

CAUTION: Static electricity can damage the electronic components of the thin client or
optional equipment. Before beginning these procedures, ensure that you are discharged of static
electricity by briefly touching a grounded metal object. See Electrostatic discharge on page 68
for more information.

3. Remove the stand, if it is installed. See Removing the stand on page 7 for more information.

4. Remove the side access panel and metal side cover, if necessary. See Removing and replacing
the side access panel and metal side cover on page 11 for more information.

5. Remove any hardware that you will replace.

6. Install or replace equipment. For removal and replacement procedures, see the following
sections:

● Removing and replacing the battery on page 15

● Installing a SODIMM on page 16

● Installing a flash memory module on page 19

● Replacing an internal hard drive on page 21

● Installing a PCI-Express card on page 24
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NOTE: Option kits include more detailed installation instructions.

7. Replace the side access panel and metal side cover. See Removing and replacing the side
access panel and metal side cover on page 11 for more information.

8. Install the stand, if you will be using the thin client unmounted in a vertical orientation. See
Installing the stand on page 6 for more information.

9. Reconnect any external devices and power cords.

10. Turn on the monitor, the thin client, and any devices you want to test.

11. Load any necessary drivers.

NOTE: You can download select hardware drivers from HP at http://www.hp.com/country/us/
eng/support.html.

12. Reconfigure the thin client, if necessary.
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Removing and replacing the side access panel and metal
side cover

Removing the side access panel

WARNING! Before removing the side access panel, ensure that the thin client is turned off and the
power cord is disconnected from the electrical outlet.

To remove the left or right access panel:

1. Remove the stand, if it is installed. See Removing the stand on page 7 for more information.

2. Press the tab on the bottom cover (1), and then slide the cover back (2) and lift it off the chassis.

Figure 2-1  Removing the bottom cover

3. Lay the thin client on its side on a secure working surface.

● Remove the right side access panel to remove or install a SODIMM.

● Remove the left side access panel to:

◦ Remove or replace the battery

◦ Install or remove a flash memory module

◦ Install or remove an internal hard drive

◦ Install or remove a PCI Express card

Removing and replacing the side access panel and metal side cover 11



4. Slide the access panel about 6.35 mm (1/4 inch) toward the bottom of the unit, and then lift the
access panel up and off the chassis.

Figure 2-2  Removing the side access panel

Removing the left metal side cover

NOTE: Do not remove the metal side cover to install a SODIMM. The SODIMM compartment is in
the right side of the chassis.

You must remove the metal side cover to access internal components such as the battery or to install
a flash memory module, internal hard drive, or PCI-Express card.

1. Push the tab in the front edge of the side cover toward the back to release the sided cover (1).

2. Lift the front edge of the metal side cover (2), then pull the cover to the front and lift it off the
chassis (3).

Figure 2-3  Removing the metal side cover

Replacing the left metal side cover

1. Place the metal side cover on the chassis, rear edge first, making sure to insert the two tabs of
the rear edge into the notches in the chassis (1).
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2. Align the tabs on both sides of the cover and press the front edge down firmly until the latch
closes.

Figure 2-4  Replacing the metal side cover

Replacing the side access panel

To replace the access panel:

1. Place the access panel on the side of the unit, offset about 6.35 mm (1/4 inch) toward the top of
the unit (1), allowing the hooks on the underside of the panel to slip into notches in the side
access panel.

2. Slide the panel toward the bottom of the unit until it locks into place (2).

Figure 2-5  Replacing the side access panel
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3. Turn the chassis upside down. Align the hooks on the underside of the bottom cover with the
slots in the chassis and press the cover down and then forward until it locks in place.

Figure 2-6  Replacing the bottom cover

4. Replace the stand, if the thin client is to be used in the tower orientation.
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Removing and replacing the battery
Before beginning the replacement process, review General hardware installation sequence on page 9
for procedures you should follow before and after installing or replacing hardware.

WARNING! You must remove the left side panel to access the battery. Before removing the side
access panel, ensure that the thin client is turned off and the power cord is disconnected from the
electrical outlet.

To remove and replace the battery:

1. Locate the battery on the system board.

2. To remove the battery, pull the metal clamp extending above the battery aside and lift the battery
out (1).

Figure 2-7  Removing and replacing the internal battery

3. To insert the replacement battery, position it with the positive side facing the chassis wall. Slide
the battery down into the slot until the clamp snaps over the edge of the battery (2).

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to www.hp.com/recycle.

Batteries, battery packs, and accumulators should not be disposed of together with the general
household waste. In order to forward them to recycling or proper disposal, please use the public
collection system or return them to HP, an authorized HP partner, or their agents.

The Taiwan EPA requires dry battery manufacturing or importing firms, in accordance with Article 15 or
the Waste Disposal Act, to indicate the recovery marks on the batteries used in sales, giveaways, or
promotions. Contact a qualified Taiwanese recycler for proper battery disposal.
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Installing thin client options
Various options can be installed on the thin client:

● Installing a SODIMM on page 16

● Installing a flash memory module on page 19

● Replacing an internal hard drive on page 21

● Installing a PCI-Express card on page 24

● Installing external drives on page 26

Installing a SODIMM

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) small outline dual inline memory modules (SODIMMs).

The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 4 GB of memory.

For proper system operation, the SODIMMs must be:

● industry-standard 204-pin

● unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

● support CAS latency 9 DDR3 1600 MHz (9-9-9 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:

● 2-Gbit non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported SODIMMs.

Before beginning the replacement process, review General hardware installation sequence on page 9
for procedures you should follow before and after installing or replacing hardware.

WARNING! You must remove the right side panel to access the SODIMM compartment. Before
removing the side access panel, ensure that the thin client is turned off and the power cord is
disconnected from the electrical outlet.

16 Chapter 2   Hardware changes



CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

To install the SODIMM:

NOTE: Populate the SODIMM sockets in the following order: SODIMM1, then SODIMM2.

1. Slide the serial number tab out of the way.

NOTE: Be sure not to lose this tab.

2. Pull the front of the access plate up, and lift it off the thin client.

Figure 2-8  Removing the SODIMM access plate

3. Align the notched edge of the SODIMM with the tab in the socket.

CAUTION: To prevent damage to the SODIMM, hold it by the edges only. Do not touch the
components on the SODIMM, and do not bend the SODIMM.
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4. Hold the SODIMM at approximately a 20-degree angle, and then press the SODIMM into the
socket (1) until it is seated. Gently apply pressure to both the left and right edges of the
SODIMM until the retention clips snap into place.

NOTE: A SODIMM can be installed in only one way. Match the notch on the SODIMM with the
tab on the socket.

Figure 2-9  Installing a SODIMM

5. Press the SODIMM down into the compartment (2).

6. If you are installing the SODIMM in the HP t610 Thin Client, place a thermal pad on the
SODIMM.

CAUTION: The thermal pad is required to help cool the SODIMM in the HP t610 Thin Client.
(The HP t610 PLUS Thin Client does not require a thermal pad.)

Figure 2-10  Installing the thermal pad in the HP t610 Thin Client
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7. Insert the tab on the front edge of the access plate into its slot (1) and press the plate down
lightly to engage the latch (2).

Figure 2-11  Replacing the SODIMM access plate

8. Slide the serial number tab back to its original position.

Installing a flash memory module

Before beginning the installation process, review General hardware installation sequence on page 9
for procedures you should follow before and after installing or replacing hardware.

WARNING! You must remove the left side panel to access the system board. Before removing the
side access panel, ensure that the thin client is turned off and the power cord is disconnected from
the electrical outlet.

CAUTION: Static electricity can damage the electronic components of the computer or optional
cards. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object. When handling a memory module, be careful not to touch
any of the contacts. Doing so may damage the module.

To install the flash memory module:

1. If an internal hard drive is installed, remove it. See Removing an internal hard drive on page 21
for instructions.
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2. Locate the correct flash memory module socket on the system board.

a. The PATA socket (1) is populated by default.

b. The SATA socket (2) can be populated with an optional SATA flash memory module.

Figure 2-12  Identifying the Flash Memory Module sockets

3. Align the connector on the flash memory module with the socket on the system board and press
the flash memory module into the socket.

NOTE: A flash memory module can be installed in only one way. Line up the hole in the flash
memory module with the retention post on the system board.

Figure 2-13  Inserting the flash memory module
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4. Press the module connectors firmly into the flash memory module socket (1), making sure that
the retention post on the system board is aligned with the hole in the module.

Figure 2-14  Securing the flash memory module

5. Insert the screw provided in the flash memory module option kit through the hole in the module
into the retention post (2) and tighten to secure the module.

Replacing an internal hard drive

Before beginning the replacement process, review General hardware installation sequence on page 9
for procedures you should follow before and after installing or replacing hardware.

WARNING! You must remove the left side panel to access the system board. Before removing the
side access panel, ensure that the thin client is turned off and the power cord is disconnected from
the electrical outlet.

Removing an internal hard drive

To remove an internal hard drive:

1. If a PCI-Express card is installed, remove it.
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2. Lift the drive bracket latch (1) and slide the drive bracket out of the retention bracket (2).

Figure 2-15  Removing the hard drive bracket from the retention assembly

3. Remove the four screws that secure the hard drive in the drive bracket (1) and remove the hard
drive from the bracket (2).

Figure 2-16  Removing the hard drive from the drive bracket

NOTE: Keep the four screws to use to install another hard drive.

Installing an internal hard drive

To install an internal hard drive:

1. If a PCIe card is installed, remove it.
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2. Insert the hard drive into the drive bracket (1) and secure it by fastening the four screws
provided in the kit (2).

Figure 2-17  Inserting the hard drive into the drive bracket

3. Locate the internal hard drive connector (1) and retention bracket (2) on the system board.

Figure 2-18  Locating the hard drive connector and retention bracket on the system board
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4. Align the screws on the side of the drive bracket with the slots inside the retention bracket and
slide the drive bracket into the retention bracket (1).

Figure 2-19  Securing the hard drive in the drive bracket

5. Press the drive bracket latch down firmly to push the drive onto the internal hard drive connector
and secure the drive assembly (2).

6. Reinstall the PCIe card, if necessary. See Installing a PCI-Express card on page 24 for
instructions.

Installing a PCI-Express card

You may install an optional PCI-Express (PCIe) card in the HP t610 PLUS Thin Client, which has a
PCIe riser card installed.

Before beginning the replacement process, review General hardware installation sequence on page 9
for procedures you should follow before and after installing or replacing hardware.

WARNING! You must remove the left side panel to access the system board. Before removing the
side access panel, ensure that the thin client is turned off and the power cord is disconnected from
the electrical outlet.
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To install a PCIe card:

1. Press down on the plastic blank tab and pull it out of the chassis.

Figure 2-20  Removing the expansion slot blank

2. Open the metal latch securing the expansion slot cover on the inside of the thin client (1) and
remove the expansion slot cover (2).

Figure 2-21  Removing the expansion slot cover

CAUTION: Do not lose this expansion slot cover. If you remove an expansion card, you must
replace it with a new card or expansion slot cover for proper cooling of internal components
during operation.
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3. Align the PCIe card connector with the PCI riser card socket and the expansion slot. Press the
PCIe card firmly into the socket to ensure that the PCIe card is seated correctly and that the
connector fits the expansion slot properly (1).

Figure 2-22  Installing the PCIe card

4. Close the metal latch to secure the PCIe card (2).

Installing external drives

Various external USB drives are available as options for the t610 Series Thin Clients. For more
information about these drives, visit http://h10010.www1.hp.com/wwpc/us/en/sm/WF12a/
12454-12454-321959.html, or refer to the instructions that accompany the option.

For more information about available options, visit the HP website at http://h10010.www1.hp.com/
wwpc/us/en/sm/WF12a/12454-12454-321959.html.
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3 Mounting the thin client

HP Quick Release
The HP t610 Series Flexible Thin Clients incorporate four mounting points on one side of the unit.
These mounting points follow the VESA (Video Electronics Standards Association) standard, which
provides industry-standard mounting interfaces for Flat Displays (FDs), such as flat panel monitors,
flat displays, and flat TVs. The HP Quick Release connects to the VESA-standard mounting points,
allowing you to mount the thin client in a variety of orientations.

NOTE: When mounting to a thin client, use the 15 mm screws supplied with the Quick Release Kit.

Figure 3-1  HP Quick Release

To order this option, visit the HP website at http://h10010.www1.hp.com/wwpc/us/en/sm/WF06c/
A10-51210-347116-329242-347116-1838057-1838058-1838059.html.
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To use the HP Quick Release with a VESA-configured thin client:

1. Using four 15 mm screws included in the mounting device kit, attach one side of the HP Quick
Release to the thin client as shown in the following illustration.

Figure 3-2  Connecting the HP Quick Release to the thin client

2. Using four screws included in the mounting device kit, attach the other side of the HP Quick
Release to the device to which you will mount the thin client. Make sure the release lever points
upward.

Figure 3-3  Connecting the HP Quick Release to another device
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3. Slide the side of the mounting device attached to the thin client (1) over the other side of the
mounting device (2) on the device on which you want to mount the thin client. An audible 'click'
indicates a secure connection.

Figure 3-4  Connecting the thin client

NOTE: When attached, the HP Quick Release automatically locks in position. You only need to
slide the lever to one side to remove the thin client.

CAUTION: To ensure proper function of the HP Quick Release and a secure connection of all
components, make sure both the release lever on one side of the mounting device and the rounded
opening on the other side face upward.
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Supported mounting options
The following illustrations demonstrate some of the supported mounting options for the mounting
bracket.

● You can mount the thin client on the back of a flat panel monitor stand.

Figure 3-5  Thin client mounted on back of monitor stand

● You can mount the thin client on a wall.

Figure 3-6  Thin client mounted on wall

● You can mount the thin client under a desk with at least one inch of clearance.
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Figure 3-7  Thin client mounted under desk
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4 Computer Setup (F10) Utility, BIOS
Settings

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including the USB, audio, or embedded NIC, so that they
cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

● Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).

● Enable or disable DriveLock security (when supported by drive).
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Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Press either Esc or F10 while the “Press the ESC key for Startup Menu” message is displayed at
the bottom of the screen.

Pressing Esc displays a menu that allows you to access different options available at startup.

NOTE: If you do not press Esc or F10 at the appropriate time, you must restart the computer
and again press Esc or F10 when the monitor light turns green to access the utility.

NOTE: You can select the language for most menus, settings, and messages using the
Language Selection option in the ESC (Startup) Menu or using the F8 key in Computer Setup.

3. If you pressed Esc, press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings or previously saved default settings (some models), select
Apply Defaults and Exit. This option will restore the original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 4-1  Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 33

Storage Computer Setup—Storage on page 34

Security Computer Setup—Security on page 36

Power Computer Setup—Power on page 40

Advanced Computer Setup—Advanced on page 41

Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
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Table 4-2  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number (some models)

● Processor type/speed/stepping

● Cache size (L1/L2)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tracking number

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup Save to Removable Media

Saves system configuration to a formatted USB flash media device.

Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup Save Current Settings as Default

Saves the current system configuration settings as the default to be used whenever “Apply
Defaults and Exit” is selected.

Restore Factory Settings as Default

Loads the original factory system configuration settings for use by a subsequent “Apply Defaults
and Exit” action.

Apply Defaults and
Exit

Applies the currently selected default settings.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.

Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 4-3  Computer Setup—Storage

Option Description
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Table 4-3  Computer Setup—Storage (continued)

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware version, serial number, connector color.

● SMART (ATA disks only)

● SSD Life Used

● Translation mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to
access disks partitioned and formatted on other systems and may be necessary for users of
older versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift,
LBA Assisted, User, and Off.

Available only when the drive translation mode is set to User, allows you to specify the
parameters (logical cylinders, heads, and sectors per track) used by the BIOS to translate
disk I/O requests (from the operating system or an application) into terms the hard drive can
accept. Logical cylinders may not exceed 1024. The number of heads may not exceed 256.
The number of sectors per track may not exceed 63.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not
be changed. If the selected translation mode is not compatible with the translation mode that
was active when the disk was partitioned and formatted, the data on the disk will be
inaccessible.

Default Values (ATA disks only)

SATA Defaults

See Translation Mode above for details.

Computer Setup (F10) Utilities 35



Table 4-3  Computer Setup—Storage (continued)

Storage Options SATA Emulation

CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are two supported options: IDE (default) and AHCI.

IDE (default option) - This is the most backwards-compatible setting of the three options.
Operating systems usually do not require additional driver support in IDE mode.

AHCI - Allows operating systems with AHCI device drivers loaded to take advantage of more
advanced features of the SATA controller.

Removable Media Boot

Enables/disables ability to boot the system from removable media. Default is enabled.

Boot Order Allows you to:

● Specify the order in which EFI boot sources (such as a internal hard drive, USB hard drive,
USB optical drive, or internal optical drive) are checked for a bootable operating system
image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

● Specify the order in which legacy boot sources (such as a network interface card, internal
hard drive, USB optical drive, or internal optical drive) are checked for a bootable operating
system image. Each device on the list may be individually excluded from or included for
consideration as a bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: You can use F5 to disable individual boot items, as well as disable EFI boot and/or
legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.

Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 4-4  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.
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Table 4-4  Computer Setup—Security (continued)

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle or reboot. If the user does not enter the correct power-on password, the unit
will not boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

● Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel ports).

● Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

● Password prompt on F9 & F12 (requires setup password to use these boot functions).
Default is enabled.

● Network Server Mode. Default is disabled.

See the Desktop Management Guide for more information.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● Embedded security device (some models)

● System audio

● USB 3.0 controller

● Network controller

● SATA Port 0

● SATA Port 1

● SATA Port 2

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

◦ USB Port 1

◦ USB Port 2

● Rear USB Ports

◦ USB Port 1

◦ USB Port 2

◦ USB3 Port 1

◦ USB3 Port 2

● Accessory USB Ports

◦ USB Port 1

Slot Security Allows you to disable any PCI Express slot. Default is enabled.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.
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Table 4-4  Computer Setup—Security (continued)

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

● Ownership tag (80-byte identifier) displayed during POST.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are
used to uniquely identify the system.)

● Keyboard locale setting for System ID entry.

Master Boot Record
Security

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.

Only appears if all of the following conditions are true:

● MBR security is enabled

● A backup copy of the MBR has been previously saved

● The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has
modified the MBR, may cause the data on the disk to become inaccessible. Only restore a
previously saved MBR if you are confident that the current bootable disk's MBR has been
corrupted or infected with a virus.
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Table 4-4  Computer Setup—Security (continued)

System Security
(some models: these
options are hardware
dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

SVM CPU Virtualization (enable/disable). Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

● Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on. Default is Do not reset.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

OS management of Embedded Security Device (some models) (enable/disable) - This option
allows the user to limit operating system control of the Embedded Security Device. Changing this
setting requires turning the computer off and then back on. This option allows the user to limit OS
control of the Embedded Security Device. Default is disabled.

Reset of Embedded Security Device through OS (some models) (enable/disable) - This option
allows the user to limit the operating system ability to request a Reset to Factory Settings of the
Embedded Security Device. Changing this setting requires turning the computer off and then back
on. Default is disabled.

NOTE: To enable this option, a Setup password must be set.

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.

See the Desktop Management Guide for more information.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 4-5  Computer Setup—Power

Option Description

OS Power
Management

● Idle Power Savings—Extended/Auto/Normal. Allows certain operating systems to decrease
the processors power consumption when the processor is idle. Default is extended.

● Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

● Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a
visual indication of what sleep state the system is in. Each sleep state has a unique blink
pattern. Default is disabled.

◦ S0 (On) = Solid green LED.

◦ S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 3 blinks and a pause.

◦ S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(green LED) — repeated cycles of 4 blinks and a pause.

◦ S5 (Soft Off) = LED is off.

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

PCI Express x16 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets
you set lower power modes that activate when the bus is not being used. Options are Disabled,
LOs, L1, LOs and L1. Default is ASPM Disabled.

PCI Express x1 Slot 1 – Sets Active State Power Management (ASPM) of the bus. ASPM lets you
set lower power modes that activate when the bus is not being used. Options are Disabled, LOs,
L1, LOs and L1. Default is ASPM Disabled.

Network Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

USB 3.0 Controller – Sets ASPM of the bus. ASPM lets you set lower power modes that activate
when the bus is not being used. Options are Disabled, LOs, L1, LOs and L1. Default is ASPM
Disabled.

Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.

40 Chapter 4   Computer Setup (F10) Utility, BIOS Settings



Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 4-6  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).

● POST messages (enable/disable). Default is disabled.

● Press the ESC key for Startup Menu (Enable/Disable). Controls display of the message at
the bottom of the POST screen during boot. It This option does not control the actual ESC
hotkey function. Default is enabled.

● Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display
a message before loading option ROMs. Default is enabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is
restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST
delay also gives you more time to select F10 to enter Computer (F10) Setup. Default is
None.

● Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

● Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the
computer not to confirm when changes were made. Default is disabled.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.
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Table 4-6  Computer Setup—Advanced (for advanced users) (continued)

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Printer mode (Bi-Directional, EPP + ECP, Output Only). Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Graphics (Auto/Disable/Force). Use this option to manage integrated (UMA)
graphics memory allocation. The value you choose is allocated permanently to graphics and
is unavailable to the operating system. For example, if you set this value to 512M on a
system with 2 GB of RAM, the system always allocates 512 MB for graphics and the other
1.5 GB for use by the BIOS and operating system. Default is Auto which sets memory
allocation to 512 MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA
memory size allocation between 32 MB and 1 GB.

● Internal Speaker (some models) (does not affect external speakers). Default is enabled.

● NIC Option ROM Download (PXE, disabled). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. The default will be to have the NIC option-ROM-enabled. Default is PXE.

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Save to Removable Media
on page 34 in the Computer Setup—File table.)

NOTE: It is recommended that you save any modified computer configuration settings to a USB
flash media device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility. (See
Restore from Removable Media on page 34 in the Computer Setup—File table.)

NOTE: Do not install the USB key that you use for rRecovery in a USB3 (blue) port.
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Changing BIOS Settings from the REPSETUP utility
Some BIOS settings may be changed locally within the operating system without having to go through
the F10 utility1. This table identifies the items that can be controlled with this method.

BIOS Setting Default Value Other Values

Setup Language English Danish, Finnish, French, German, Italian, Japanese, Dutch, Norwegian,
Portuguese, Swedish, Spanish

Removable Media
Boot

Enable Disable

SATA Emulation IDE AHCI

EFI Boot Order USB Floppy/CD USB Hard Drive, ATAPI CD-ROM Drive, ATAPI CD-ROM Drive, Other

Legacy Boot Order USB Floppy/CD Hard Drive, Network Controller, ATAPI CD-ROM Drive, PnP Device #1 - #10

Lock Legacy
Resources

Disable Enable

Network Server
Mode

Disable Enable

Setup Browse Mode Disable Enable

Password prompt on
F9 & F12

Enable Disable

Cover Removal
Sensor

Disable Notify User, Setup Password

Front USB Ports Enable Disable

Front USB Port 1 &
2

Disable Enable

Rear USB Ports Enable Disable

Rear USB Port 1 & 2 Disable Enable

Rear USB3 Port 1 &
2

Disable Enable

Accessory USB
Ports

Enable Disable

Accessory USB Port
1

Disable Enable

PCI Express x16
Slot 1

Disable Enable

PCI Express x1 Slot
1

Disable Enable

Embedded Security
Device

Device available Device hidden

System Audio Device available Device hidden

Network Controller Device available Device hidden

USB 3.0 Controller Device available Device hidden

SATA0 Device available Device hidden
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SATA1 Device available Device hidden

SATA2 Device available Device hidden

Network Service
Boot

Disable Enable

Enter Ownership
Tag

na na

Enter UUID na na

Data Execution
Prevention

Disable Enable

SVM CPU
Virtualization

Disable Enable

Activate Embedded
Security On Next
Boot

Disable Enable

Embedded Security
Activation Policy

F1 to Boot Allow user to reject, No Prompts

OS management of
Embedded Security
Device

Disable Enable

Reset of Embedded
Security Device
through OS

Disable Enable

Master Boot Record
Security

Disable Enable

Runtime Power
Management

Enable Disable

Idle Power Savings Extended Normal, Auto

Unique Sleep State
Blink Rates

Disable Enable

S5 Maximum Power
Savings

Disable Enable

SATA Power
Management

Disable Enable

Fan Idle Mode + ++, +++, ++++, +++++, ++++++

POST Mode QuickBoot FullBoot, FullBoot Every 07 Days, 14 Days, 21 Days, 28 Days, Clear Memory

POST Messages Disable Enable

Press ESC for
Startup Menu
Prompt

Enable Disable

Option ROM Prompt Enable Disable

Remote Wakeup
Boot Source

Local Hard Drive Remote Server

After Power Loss Off On Previous State
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POST Delay (in
seconds)

None 5, 10, 15, 20

Bypass F1 Prompt
on Configuration
Changes

Disable Enable

Sunday – Saturday Disable Enable

BIOS Power-On
Time (hh:mm)

00:00 na

PCI SERR#
Generation

Enable Disable

PCI VGA Palette
Snooping

Disable Enable

Printer Mode EPP+ECP Bi-Directional, Output-Only

Num Lock State at
Power-On

Off On

Integrated Video Auto Disable, Force

UMA Size 512M 32M, 64M, 256M, 512M, 1G

Internal Speaker Enable Disable

NIC Option ROM
Download

PXE Disable

Serial Port A IO=3F8; IRQ=4 Disabled, IO=3F8; IRQ=3, IO=2F8; IRQ=4, IO=2F8; IRQ=3, IO=3E8; IRQ=4,
IO=3E8; IRQ=3, IO=2E8; IRQ=4, IO=2E8; IRQ=3, IO=3F8; IRQ=6, IO=3F8;
IRQ=5, IO=2F8; IRQ=6, IO=2F8; IRQ=5, IO=3E8; IRQ=6, IO=3E8; IRQ=5,
IO=2E8; IRQ=6, IO=2E8; IRQ=5

Serial Port B IO=2F8; IRQ=3 IO=3F8; IRQ=4, IO=3F8; IRQ=3, IO=2F8; IRQ=4, IO=3E8; IRQ=4, IO=3E8;
IRQ=3, IO=2E8; IRQ=4, IO=2E8; IRQ=3, IO=3F8; IRQ=6, IO=3F8; IRQ=5,
IO=2F8; IRQ=6, IO=2F8; IRQ=5, IO=3E8; IRQ=6, IO=3E8; IRQ=5, IO=2E8;
IRQ=6, IO=2E8; IRQ=5

Parallel Port IO=378; IRQ=7;
DMA=1

Disable, IO=378; IRQ=7, IO=278; IRQ=7, IO=3BC; IRQ=7, IO=378; ,
IO=278; , IO=3BC, IO=378; IRQ=7; DMA=3, IO=278; IRQ=7; DMA=1,
IO=278; IRQ=7; DMA=3, IO=3BC; IRQ=7; DMA=1, IO=3BC; IRQ=7; DMA=3

Default Setup Leave Defaults As Is
(No Update)

Save Current Settings as Default, Restore Factory Settings as Default

Apply Defaults and
Exit

Do Not Apply Apply

Power-On Password na na

Setup Password na na

NOTE: Settings that can be controlled from the operating system with repset can also be controlled
remotely by sending the client an Altiris job that uses the repset tool to apply the setting changes.
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5 Diagnostics and Troubleshooting

LEDs

Table 5-1  Power and IDE Flash Activity LEDs

LED Status

Power LED Off When the unit is plugged into the wall socket and the Power LED is off, the unit is powered off.
However, the network can trigger a Wake On LAN event in order to perform management
functions.

Power LED On Displays during boot sequence and while the unit is on. During boot sequence, hardware
initialization is processed and startup tests are performed on the following:

● Processor initialization

● Memory detection and initialization

● Video detection and initialization

NOTE: If one of the tests fails, the unit will simply stop, but the LED will stay on. If the video
test fails, the unit beeps. There are no messages sent to video for any of these failed tests.

NOTE: After the video is initialized, anything that fails will have an error message.

NOTE: RJ-45 LEDs are located inside the RJ-45 connector on the top, rear panel of the thin client. The LEDs are visible
when the connector is installed. Blinking green indicates network activity, and amber indicates a 100MB speed connection.

IDE LED is Off When the unit is powered on and the flash activity light is off, then there is no access to the
system flash.

IDE LED blinks Green Indicates the system is accessing the internal IDE flash.
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Wake-on LAN
Wake-on LAN (WOL) allows a computer to be turned on or resumed from sleep or hibernation state
by a network message. You can enable or disable WOL in Computer Setup using the S5 Maximum
Power Savings setting.

To enable or disable WOL:

1. Turn on or restart the computer.

2. Press either Esc or F10 while the “Press the ESC key for Startup Menu” message is displayed at
the bottom of the screen.

NOTE: If you do not press Esc or F10 at the appropriate time, you must restart the computer
and again press Esc or F10 when the monitor light turns green to access the utility.

3. If you pressed Esc, press F10 to enter Computer Setup.

4. Navigate to Power > Hardware Power Management.

5. Set S5 Maximum Power Savings as follows:

● Disable WOL = Enabled

● Enable WOL = Disabled

6. Press F10 to accept any changes.

7. Select File > Save Changes and Exit.

Power-On Sequence
At power-on, the flash boot block code initializes the hardware to a known state, then performs basic
power-on diagnostic tests to determine the integrity of the hardware. Initialization performs the
following functions:

1. Initializes CPU and memory controller.

2. Initializes VGA software.

3. Initializes and configures all PCI devices.

4. Initializes the video to a known state.

5. Initializes USB devices to a known state.

6. Performs power-on diagnostics. For more information, see “Power-On Diagnostic Tests”.

7. The unit boots the operating system.
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Resetting the Administrator and power-on passwords
You can reset the Administrator and power-on passwords as follows:

1. Turn off the computer and disconnect the power cord from the power outlet.

2. Remove the side access panel and the metal side cover.

3. Remove the password jumper from the system board header labeled PSWD.

4. Replace the metal side cover and the side access panel.

5. Connect the computer to AC power, and then turn on the computer.

6. Turn off the computer and disconnect the power cord from the power outlet.

7. Remove the side access panel and the metal side cover.

8. Replace the password jumper.

9. Replace the metal side cover and the side access panel.

Power-On Diagnostic Tests
The Power-on diagnostics performs basic integrity tests of the hardware to determine its functionality
and configuration. If a diagnostic test fails during hardware initialization the unit simply stops. There
are no messages sent to video.

NOTE: You may try to restart the unit and run through the diagnostic tests a second time to confirm
the first shutdown.

The following table lists the tests that are performed on the t610 units.

Table 5-2  Power-On Diagnostic Test

Test Description

Boot Block Checksum Tests boot block code for proper checksum value

DRAM Simple write/read pattern test of the first 640k of memory

Parallel Port Initiates the port’s driver and determines if the device is present

Serial Port Tests the serial port using simple port verification test to determine if ports are
present

Timer Tests timer interrupt by using polling method

RTC CMOS battery Tests integrity of RTC CMOS battery

NAND flash device Tests for proper NAND flash device ID present
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Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

NOTE: Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table 5-3  Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

Green Power LED On. None Computer on. None

Green Power LED flashes
every two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the
mouse to wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

2 Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heat sink/fan
assembly is not properly
attached to the processor.

OR

The unit has vents
blocked or is in a location
where the ambient
temperature is too high.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
plugged in and running, if equipped.

2. Contact an authorized reseller or service
provider.

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

4 Power failure (power
supply is overloaded).

OR

The incorrect external
power supply adapter is
being used on the unit.

1. Check if a device is causing the problem by
removing ALL attached devices. Power on
the system. If the system enters the POST,
then power off and replace one device at a
time and repeat this procedure until failure
occurs. Replace the device that is causing
the failure. Continue adding devices one at
a time to ensure all devices are functioning
properly.

2. Replace the power supply.

3. Replace the system board.
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Table 5-3  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the memory
modules or the system board, you must unplug
the computer power cord before attempting to
reseat, install, or remove a memory module.

1. Reseat memory modules.

2. Replace memory modules one at a time to
isolate the faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace
the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

8 Invalid ROM based on
bad checksum.

1. Reflash the system ROM with the latest
BIOS image using the BIOS Recovery
procedure.

2. Replace the system board.

System does not power on
and LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Remove the power cord from the computer.

2. Open the computer and press the yellow
CMOS button on the system board for 4
seconds (located near the front USB ports).

3. Verify that the AC cord is plugged into the
power supply.

4. Close the unit and reattach the power cord.

5. Try to power on the computer.

6. Replace the unit.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table 5-4  Numeric Codes and Text Messages

Control panel message Description Recommended action

103-System Board Failure DMA or timers. 1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card
contains an option ROM too large to
download during POST.

1. If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the
internal NIC from being downloaded
during POST to free more memory for
an expansion card's option ROM.
Internal PXE option ROM is used for
booting from the NIC to a PXE server.

161-Real-Time Clock Power Loss Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

201-Memory Error RAM failure. 1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.
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Table 5-4  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest
BIOS image.

512-Chassis, Rear Chassis, or Front
Chassis Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic
utilities.
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Troubleshooting

Basic Troubleshooting

If the thin client is experiencing operating problems or will not power on, review the following items.

Table 5-5  Power-On Troubleshooting

Issue Procedures

The thin client unit is experiencing
operating problems.

Ensure that the following connectors are securely plugged into the thin client
unit:

● Power connector

● Keyboard

● Mouse

● Network RJ-45 connector

● Monitor

The thin client unit does not power on. 1. Verify that the power supply is good by installing it on a known working
unit and testing it. If the power supply does not work on the test unit,
replace the power supply.

2. If the unit does not work properly with the replaced power supply, have the
unit serviced.

The thin client unit powers on and displays
a splash screen, but does not connect to
the server.

1. Verify that the network is operating and the network cable is working
properly.

2. Verify that the unit is communicating with the server by having the System
Administrator ping the unit from the server:

◦ If the thin client pings back, then the signal was accepted and the unit
is working. This indicates a configuration issue.

◦ If the thin client does not ping back and the thin client does not
connect to the server, re-image the unit.

No link or activity on the network RJ-45
LEDs or the LEDs do not illuminate
blinking green after powering on the thin
client unit. (The network LEDs are located
inside the RJ-45 connector on the top, rear
panel of the thin client. Indicator lights are
visible when the connector is installed.)

1. Verify that the network is not down.

2. Make sure the RJ-45 cable is good by installing the RJ-45 cable onto a
known working device—if a network signal is detected then the cable is
good.

3. Verify the power supply is good by replacing the power cable to the unit
with a known working power supply cable and testing it.

4. If network LED's still do not light and you know the power supply is good,
then re-image the unit.

5. If network LED’s still do not light, run the IP configuration procedure.

6. If network LED’s still do not light, have the unit serviced.
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Table 5-5  Power-On Troubleshooting (continued)

A newly connected unknown USB
peripheral does not respond or USB
peripherals connected prior to the newly
connected USB peripheral will not
complete their device actions.

An unknown USB peripheral may be connected and disconnected to a running
platform as long as you do not reboot the system. If problems occur, disconnect
the unknown USB peripheral and reboot the platform.

Video does not display. 1. Verify that the monitor brightness is set to a readable level.

2. Verify the monitor is good by connecting it to a known working computer
and ensure its front LED turns green (assuming the monitor is Energy Star
compliant). If the monitor is defective, replace it with a working monitor
and repeat testing.

3. Re-image the thin client unit and power on the monitor again.

4. Test the thin client unit on a known working monitor. If the monitor does
not display video, replace the thin client unit.

Diskless (No-Flash) Unit Troubleshooting

This section is only for those units that do not have ATA Flash capability. Because there is no ATA
Flash in this model the boot priority sequence is:

● USB device

● PXE

1. When the unit boots, the monitor should display the following information:

Table 5-6  Diskless Unit Troubleshooting

Item Information Action

MAC Address NIC portion of the system board is
OK

If no MAC Address, the system board is at fault.
Contact the Call Center for service.

GUID General system board information If no GUID information, the system board is at fault and
should be replaced.

Client ID Information from server If no Client ID information there is no network
connection. This may be caused by a bad cable, the
server is down, or a bad system board. Contact the Call
Center for service for the bad system board.

MASK Information from server If no MASK information there is no network connection.
This may be caused by a bad cable, the server is down,
or a bad system board. Contact the Call Center for
service for the bad system board.

DHCP IP Information from server If no DHCP IP information there is no network
connection. This may be caused by a bad cable, the
server is down, or a bad system board. Contact the Call
Center for service for the bad system board.

If you are running in an Microsoft RIS PXE environment go to step 2.
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If you are running in a Linux environment go to step 3.

2. If you are running in a Microsoft RIS PXE environment press the F12 key to activate the network
service boot as soon as the DHCP IP information appears on the screen.

If the unit does not boot to the network the server is not configured to PXE.

If you missed the F12 cue, the system will try to boot to the ATA flash that is not present. The
message on the screen will read: ERROR: Non-system disk or disk error. Replace and press
any key when ready.

Pressing any key will restart the boot cycle.

3. If you are running in a Linux environment an error message will appear on the screen if there is
no Client IP. ERROR: Non-system disk or disk error. Replace and press any key when
ready.
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6 Restoring the Flash Image

System Requirements
To create a recovery device for the purpose of reflashing or restoring the software image on the
ROM, you will need the following:

● A personal computer running Microsoft Windows XP Professional, Windows Vista, or Windows
7.

● One or more HP t610 Series Thin Clients

● 4-GB USB flash device for Microsoft Windows Embedded Standard 2009 (WES) (if using the
USB format) or Linux.

This restore method will not work with all USB flash devices. USB flash devices with
multiple partitions generally do not support this restore method. The range of USB flash devices
available on the market is constantly changing. Not all USB flash devices have been tested with
the HP Thin Client Imaging Tool.

Before using the utility, you must download the appropriate image from http://www.hp.com.

Getting Started
There are two deployment options supported by this utility. You can choose to do one or more of the
following using your personal computer:"

● Create a bootable flash image on a USB flash device.

● Unbundle the image to a directory for use in a custom deployment scenario or PXE image.

Download and run the Package-for-the-Web deliverable (an .exe file) that contains the original factory
image for the thin client. The HP Thin Client Imaging Tool (CRStart.exe) runs automatically.

Choose one of the deployment options: Each option is described in the following paragraphs.

● USB Format

● Deployment

During the restore process, the thin client flash drive will be reformatted and all data on it will
be erased before the system image is copied to it. To prevent loss of data, be sure that you
have saved any user-created data from the flash drive. During the first restart of the thin client
following the restore process, it may take approximately 15 minutes to unbundle the software
before the Windows Desktop is displayed.

56 Chapter 6   Restoring the Flash Image

http://www.hp.com


Formatting a USB Flash Drive
CAUTION: To prevent loss of data, be sure that you have saved any user-created data from the
USB drive to another drive.

1. Connect your USB flash device (drive key) to your personal computer. Ensure that only one USB
flash device is connected to the system.

2. Click USB Format.

3. Select the USB drive from the list, using the up and down arrows to display the correct drive
letter. (If the USB drive does not appear in the list, click Update Drives, then scroll through the
list again.)

During the next step, the USB drive will be reformatted and all data on it will be erased before
the bootable image is copied to it. To prevent loss of data, be sure that you have saved any data
from the USB drive to another drive.

4. Click Format.

Connect the bootable USB flash device to the thin client. Only one bootable USB device may be
attached to the thin client during this process.

5. Restart the thin client.

6. When prompted Do you want to continue? [Y/N] click Y to begin the image restore process on
the thin client.

Unpacking the Image and Tools for Deployment
1. Click Deployment.

2. When prompted, select the destination directory for the imaging tools and image.

The components that comprise DSKIMG.BIN are then unbundled. When this process is complete,
there are three new files: IBR.EXE (the image restoration utility), FLASH.xx (the OS image), and
README.TXT

NOTE: Linux uses the file name FLASH.DD while other operating system images use FLASH.IMG

Deploying with PXE
1. Ensure that IBR.exe and Flash.img are stored in the same directory on the server.

2. Add [full path]\IBR.exe -y [full path]\Flash.img hd0 to the PXE command file,
and then run it.

To view the IBR command line options: At the command prompt, type IBR.EXE /? and press Enter.

Refer to Configuring a PXE Server on page 62 for instructions about setting up a PXE Server using
Microsoft RIS. See your documentation if using a different PXE server, such as Altiris Deployment
Solution.
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A Specifications

Table A-1  HP t610 Thin Client

Dimensions

Width (front to back)

Height (top to bottom, without stand)

Depth (side to side)

220 mm

240 mm

40 mm

8.7 in.

9.4 in

1.6 in.

Approximate Weight (without stand) 1.49 kg 3.29 lb

Temperature Range (fanless design)*

Operating**

(max. rate of change is 10° C per hour or 18° F per hour)

Nonoperating

(max. rate of change is 20° C per hour or 36° F per hour)

10° to 40° C

-30° to 60° C

50° to 104° F

-22° to 140° F

*Specifications are at sea level with altitude derating of
1° C/300m (1.8° F/1000ft) to a maximum of 3km
(10,000ft), with no direct, sustained sunlight. Upper limit
may be limited by the type and number of options
installed.

** The operating temperature range when the thin
client is attached to a flat panel using the HP Quick
Release is 50° to 95° F (10° to 35° C).

Relative Humidity (non-condensing)

Operating

(max. wet bulb temperature is 28° C or 84.2° F)

Nonoperating

(max. wet bulb temperature is 38.7° C or 101.6° F)

10–90%

5–95%

10–90%

5–95%

Maximum Altitude (unpressurized)

Operating

(max. allowed rate of change is 457 m per minute or 1500
ft per minute)

Nonoperating

(max. allowed rate of change is 457 m per minute or 1500
ft per minute)

3048 m

9,144 m

10,000 ft

30,000 ft
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Table A-1  HP t610 Thin Client (continued)

Power Supply

Operating Input Voltage Range

Rated Line Frequency

100–240 VAC

50–60 Hz

100–240 VAC

50–60 Hz

Power Output (maximum) 65 W 65 W

Table A-2  HP t610 PLUS Thin Client

Dimensions

Width (front to back)

Height (top to bottom, without stand)

Depth (side to side)

220 mm

240 mm

65 mm

8.7 in.

9.4 in

2.6 in.

Approximate Weight (without stand) 1.98 kg 4.37 lb

Temperature Range (fanless design)*

Operating**

(max. rate of change is 10° C per hour or 18° F per hour)

Nonoperating

(max. rate of change is 20° C per hour or 36° F per hour)

10° to 40° C

-30° to 60° C

50° to 104° F

-22° to 140° F

*Specifications are at sea level with altitude derating of
1° C/300m (1.8° F/1000ft) to a maximum of 3km
(10,000ft), with no direct, sustained sunlight. Upper limit
may be limited by the type and number of options
installed.

** The operating temperature range when the thin
client is attached to a flat panel using the HP Quick
Release is 50° to 95° F (10° to 35° C).

Relative Humidity (non-condensing)

Operating

(max. wet bulb temperature is 28° C or 84.2° F)

Nonoperating

(max. wet bulb temperature is 38.7° C or 101.6° F)

10–90%

5–95%

10–90%

5–95%

Maximum Altitude (unpressurized)

Operating

(max. allowed rate of change is 457 m per minute or 1500
ft per minute)

Nonoperating

(max. allowed rate of change is 45 7m per minute or 1500
ft per minute)

3048 m

9,144 m

10,000 ft

30,000 ft
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Table A-2  HP t610 PLUS Thin Client (continued)

Power Supply

Operating Input Voltage Range

Rated Line Frequency

100–240 VAC

50–60 Hz

100–240 VAC

50–60 Hz

Power Output (maximum) 85 W 85 W
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B Adding an Image Restore Tool

1. Ensure that the boot order is set to use the Network as the first boot device.

2. Ensure that IBR.exe (Image Restore) and Flash.dd are stored in the same directory on the
server. (e.g., c:\program files\altiris\express\deployment server\images)

3. From the Altiris Deployment Server Console, click File > New > Job .

4. Enter a unique name for the job that you will use to deploy the original thin client image.

5. Click the name of the new job.

6. Near the upper right side of the screen, click Add.

7. Select Run Script from the menu.

8. Type [full path]images\ibr\exe-y\images\flash.xx hd0

NOTE: Linux uses the file name FLASH.DD while other operating system images use
FLASH.IMG

9. Under In which OS would you like to run this script? Click DOS.

10. Click Finish.

11. You can now drag and drop the job onto the appropriate machine(s) or schedule it to run later,
depending on your needs. Refer to the documentation for Altiris Deployment Solution
(http://www.altiris.com/support/documentation) for more detailed information.
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C Configuring a PXE Server

Prerequisites
NOTE: This Troubleshooting section is not intended to enable HP Service to support PXE software.
All PXE software is supported by authorized service providers on a warranty or service contract basis.
Customers that call the HP Customer Service Center with PXE issues and questions should be
referred to their PXE provider for assistance.

Additionally, refer to the following:

– For Windows 2000: http://support.microsoft.com/kb/891275

– For Windows 2003: http://technet.microsoft.com/en-us/library/cc766320(WS.10).aspx

The services listed below must be running, and they may be running on different servers:

1. Domain Name Service (DNS)

2. Active Directory DHCP

3. Remote Installation Services (RIS) on Microsoft Windows 2000 Server

This documentation covers RIS setup, and assumes that servers 1, 2, and 3 (above) are already set
up. The RIS PXE Server must be equipped with two or more hard drives. Remote Installation
Services and Windows 2000 Server cannot be installed on the same drive; nor will RIS work on a
double partition of Windows 2000 Server. You must first format the drive on which RIS is installed
using NTFS.

Installing Remote Installation Services (RIS PXE Server)
1. From the Windows 2000 Server, log on to the domain using an account that has Administrator

privileges on the server.

2. From the Windows Control Panel, double-click on Add/Remove Programs.

3. Double-click Add/Remove Windows Components.

4. Select Remote Installation Services, then click Next. (Insert Windows Server CD into the CD-
ROM drive, if prompted.)

5. Restart the computer after the wizard has finished installing the service.
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Authorizing Remote Installation Services (RIS PXE
Server)

If you have installed RIS on a server other than the server running DHCP, authorize PXE with DHCP
as follows:

1. Record the IP address of the RIS PXE Server.

2. Log on to the DHCP Server as administrator.

3. From the Control Panel, double-click Administrative Tools.

4. Double-click DHCP.

5. Right-click DHCP (just above the domain name) and select Manage Authorized Servers.

6. Click Authorize.

7. Type the IP address of your RIS PXE server and click OK.

8. Click OK.

9. Log off from the DHCP Server.

Configuring Remote Installation Services
Use the default option to have RIS install on second hard drive (D:\ or E:\).

1. Click Start > Run.

2. Type Risetup.exe and click Next.

3. Click Next.

4. Select Respond to client computers requesting service.

5. Click Next.

6. Insert the Windows 2000 Professional CD into the CD-ROM drive and enter the path to the CD-
ROM drive (usually drive D:\ or E:\).

7. Click Next.

8. Click Next.

9. Click Next.

10. When the installation is complete, click Finish.

Set User Permissions on the Active Directory Server
On the active directory server:

1. Click Start > Programs > Administrative Tools.

2. Click Active Directory Users and Computers.

3. Right-click on the appropriate domain name
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4. Click Delegate Control.

5. Click Next.

6. Click Add to add users.

7. Highlight Everyone and click Add.

8. Click OK.

9. Click Next.

10. Select Join a Computer to the Domain.

11. Click Next.

12. Click Finish.

RIS Menu
1. Install the RIS menu of your choice.

2. Configure the RIS menu.

3. Refer to the help file provided by the RIS menu for instructions on creating a network bootable
diskette and RIS menu for PXE.

Creating Network Bootable Disk to Map Drives
Create a network boot disk to map drives. (Refer to the Microsoft Web site for instructions about
creating a network bootable diskette.)

For More Information
HP thin client documentation (including white papers discussing software deployment methods):
http://welcome.hp.com/country/us/en/support.html?pageDisplay=support. Type your model number
into the for product box and navigate to the Manuals link.

Altiris Deployment Solution Documentation: http://www.altiris.com/support/documentation/
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D System BIOS

Updating or restoring a BIOS
Windows BIOS Flashing

You can use the BIOS Flash Update SoftPaq to restore or upgrade the system BIOS. Several
methods for changing the BIOS firmware stored on your computer are available .

HPQFlash.exe is a utility designed to flash the System BIOS within a Microsoft Windows
environment. To display the available options for this utility, type [Path]\HPQFlash -? at a command
prompt or local search box. If the system has a BIOS Setup password enabled, then HPQFlash will
prompt for you to enter the password before completing the flash process.

You can also run HPQFlash.exe from a USB storage device, including flash memory devices and
external hard drives. To do this, insert the device and take note of the assigned drive letter. Copy
HPQFlash.exe and ROM.CAB to the root of the drive indicated by the drive letter, or a folder on that
drive. You can then execute HPQFlash from its location on the USB device. If the system has a BIOS
Setup password enabled, then HPQFlash will prompt for you to enter the password before completing
the flash process.

For more information, view Readme.txt or HPQFlash.txt, both located in the HPQFlash folder in the
SoftPaq.

Startup Menu / F10 Setup BIOS Flashing

A BIOS upgrade option is available through both the Startup Menu and the F10 Setup utility using the
"Flash System ROM" feature. Reboot the computer and press the Esc key to display the Startup
Menu. Use the arrow keys to select Utilities, and then select the Flash System ROM option.
Alternatively, reboot the PC and press F10 to access the BIOS Setup utility. In the File menu, select
Flash System ROM. Either method requires that removable media be present that contains the BIOS
binary image file in the root directory. You can find the binary image file in the DOS Flash folder. The
image is named xxx_MMmm.bin, where "xxx" is the BIOS family, "MM" is the major version number,
and "mm" is the minor version number. To create a CD for updating the BIOS, use a blank CD-R or
CD-RW disk on a system with a CD-RW or DVD+RW drive, and write the binary to the disk using any
CD-burning software. If a BIOS Setup password is set, the password is required before you can
access the Flash System ROM menu. You are notified when the process completes. The new BIOS
code will not take effect until you restart the PC.

USB Device BIOS Flashing in DOS

DOS Flash (DOSFlash.exe, FlshUefi.cpu) is the DOS-compatible System BIOS flash utility that you
can use from a DOS bootable storage device (where "DOS" refers to any of a number of compatible
operating systems such as FreeDOS, MS-DOS or DR-DOS). FlshUefi.cpu is the required driver for
DOSFlash.exe. To flash the System BIOS from a bootable USB storage device, copy the contents of
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the DOS Flash folder to the USB device, boot the computer from the USB device, and execute the
DOSFlash application.

To see a more complete description of the DOS flash utilities, view DOSFlash.txt located in the DOS
Flash folder of the SoftPaq. This folder also contains the required binary image of the BIOS. The
binary image file is named xxx_MMmm.bin where "xxx" is the BIOS family, "MM" is the major version
number, and "mm" is the minor version number. You can copy this file to the root directory of any
USB removable medium for use with the F10 setup "Flash System ROM" option or BootBlock
Emergency Recovery Mode.

Linux BIOS Flashing

You can use the hp-flash utility and its associated driver to update the BIOS on systems running
Linux. After the driver loads, execute the utility from a command prompt with administrator privileges.
The HP ThinPro or HP Smart Client Linux OS images include the utility for updating the BIOS, but the
binary file to flash must be copied from the DOS Flash folder to the unit. Review the README.txt file
for more specific instructions in the SoftPaq. The Linux Flash folder also contains the files necessary
to build the BIOS flash driver module for the particular kernel being used; the hp-flash utility is not
kernel-dependent other than the choice of 32-bit (i686) and 64-bit (x86_64) flavors.

System Software Management (SSM) BIOS Flashing

Use this SoftPaq with System Software Manager (SSM) to update the System BIOS on target
computers on a network. Place this SoftPaq in your SSM Filestore folder and then update the
database. SSM is a free utility provided by Hewlett-Packard Company. For information on SSM, see
http://www.hp.com/go/ssm.

HP Client Manager Software (HPCMS) BIOS Flashing

Use this Softpaq with HP Client Manager Software (HPCMS) and Altiris Notification Server to
remotely target, distribute, and update the System BIOS on network PCs. Place this SoftPaq in your
HPCMS Filestore folder and then update the database. HPCMS is a free managment application
provided by Altiris and Hewlett-Packard Company. For more information, see http://www.hp.com/go/
EasyDeploy.

Network BIOS Flashing

We designed the DOS Flash utility to support System BIOS flashing from a remote network boot
using PXE. DOS Flash uses a small memory footprint that is compatible with the limited DOS
memory available and the DOS extended environment that may exist while running Altiris eXpress.
To see a more complete description of the network BIOS flashing utilities, view the DOSFlash.txt file
located in the DOS Flash folder.

BitLocker Drive Encryption / BIOS Measurements

If you have Windows BitLocker Drive Encryption (BDE) enabled on your system, we recommend that
you temporarily suspend BDE before updating the BIOS. You should also obtain your BDE recovery
password or recovery PIN before suspending BDE. After the you flash the BIOS, you can resume
BDE.

To make a change to BDE, select Start > Control Panel > BitLocker Drive Encryption, click
Suspend Protectionor Resume Protectionand then click Yes.

As a general rule, updating the BIOS will modify measurement values stored in the Platform
Configuration Registers (PCRs) of the system's security module. Temporarily disable technologies
that use these PCR values to ascertain platform health (BDE is one such example) prior to flashing
the BIOS. Once you update the BIOS, re-enable the functions and restart the system so that you can
take new measurements.
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BootBlock Emergency Recovery Mode

In the event of a failed BIOS update (for example if power is lost while updating), the System BIOS
may become corrupted. BootBlock Emergency Recovery Mode detects this condition and
automatically searches the root directory of the hard drive and any USB media sources for a
compatible binary image. Copy the binary (.bin) file in the DOS Flash folder to the root of the desired
storage device, and then power on the system. Once the recovery process locates the binary image,
it attempts the recovery process. The automatic recovery continues until it successfully restores or
updates the BIOS. If the system has a BIOS Setup password, you may need to use the Startup
Menu / Utilities submenu to flash the BIOS manually after providing the password. Sometimes there
are restrictions on which BIOS versions are allowed to be installed on a platform. If the BIOS that was
on the system had restrictions, then only allowable BIOS versions may be used for recovery.
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E Electrostatic discharge

A discharge of static electricity from a finger or other conductor may damage system boards or other
static-sensitive devices. This type of damage may reduce the life expectancy of the device.

Preventing electrostatic damage
To prevent electrostatic damage, observe the following precautions:

● Avoid hand contact by transporting and storing products in static-safe containers.

● Keep electrostatic-sensitive parts in their containers until they arrive at static-free workstations.

● Place parts on a grounded surface before removing them from their containers.

● Avoid touching pins, leads, or circuitry.

● Always be properly grounded when touching a static-sensitive component or assembly.

Grounding methods
There are several methods for grounding. Use one or more of the following methods when handling
or installing electrostatic-sensitive parts:

● Use a wrist strap connected by a ground cord to a grounded Thin Client chassis. Wrist straps
are flexible straps of 1 megohm +/- 10 percent resistance in the ground cords. To provide proper
grounding, wear the strap snug against the skin.

● Use heelstraps, toestraps, or bootstraps at standing workstations. Wear the straps on both feet
when standing on conductive floors or dissipating floor mats.

● Use conductive field service tools.

● Use a portable field service kit with a folding static-dissipating work mat.

If you do not have any of the suggested equipment for proper grounding, contact an HP authorized
dealer, reseller, or service provider.

NOTE: For more information about static electricity, contact an HP authorized dealer, reseller, or
service provider.
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